NuMicro® Family
NuMaker UNO
User Manual

The information described in this document is the exclusive intellectual property of Nuvoton Technology Corporation and shall not be reproduced without permission from Nuvoton.

Nuvoton is providing this document only for reference purposes of NuMicro microcontroller based system design. Nuvoton assumes no responsibility for errors or omissions.

All data and specifications are subject to change without notice.

For additional information or questions, please contact: Nuvoton Technology Corporation.

www.nuvoton.com
# Table of Contents

1. OVERVIEW .................................................................................................................. 3

2. FEATURES ................................................................................................................... 4

3. INTRODUCTION TO NUMAKER UNO DEVELOPMENT BOARD ......................... 5
   3.1 NuMaker UNO Jumper Description ........................................................................ 7
   3.2 Pin Assignment for NUC131SD2AE Extended Connectors ....................................... 8
   3.3 NuMaker UNO NUC131SD2AE Extended Connectors Layout ................................. 9
   3.4 Arduino UNO Pin Assignment for NuMaker UNO .................................................... 10
   3.5 NuMaker UNO Arduino Layout ............................................................................. 11
   3.6 NuMaker UNO PCB Placement ............................................................................. 12

4. DOWNLOADING AND INSTALLING ARDUINO IDE 1.8.5 AND NUMAKER UNO SOFTWARE .................................................................................................................. 13
   4.1 Downloading and Installing Arduino IDE 1.8.5 Software ........................................ 13
   4.2 Installing Nu-Link USB Driver for Arduino IDE 1.8.5 ............................................. 16
   4.3 Hardware Setup ..................................................................................................... 20
   4.4 Testing USB and VCOM Device in the Device Manager ........................................ 20

5. STARTING TO USE NUMAKER UNO ON ARDUINO IDE 1.8.5 .......................... 21
   5.1 Compiling and Executing Example Program ........................................................... 21

6. STARTING TO USE NUMAKER UNO ON KEIL µVision® IDE .......................... 26
   6.1 Downloading and Installing Keil µVision® IDE Software ....................................... 26
   6.2 Downloading and Installing Nu-Link Keil Driver .................................................... 26
   6.3 Hardware Setup ..................................................................................................... 26
   6.4 Procedure for Downloading and Debugging Example Program ............................ 26

7. STARTING TO USE NUMAKER UNO ON IAR EMBEDDED WORKBENCH ........ 33
   7.1 Downloading and Installing IAR Embedded Workbench Software ........................... 33
   7.2 Downloading and Installing Nu-Link IAR Driver .................................................... 33
   7.3 Hardware Setup .................................................................................................... 33
   7.4 Procedure for Downloading and Debugging Example Program ............................ 33

8. DOWNLOADING NU-LINK DRIVER FROM NUVOTON WEBSITE .................. 36
   8.1 Downloading and Installing Nu-Link Keil Driver .................................................... 36
   8.2 Downloading and Installing Nu-Link IAR Driver ..................................................... 38

9. NUMAKER UNO SCHEMATICS ........................................................................... 40
   9.1 NuMaker UNO I/O Schematic ............................................................................... 40
   9.2 NuMaker UNO NUC131SD2AE Schematic ............................................................ 41
   9.3 Nu-Link-Me Schematic ....................................................................................... 42

10. REVISION HISTORY .............................................................................................. 43
1 OVERVIEW

Arduino is an open-source electronics platform based on easy-to-use hardware and software. The NuMicro® NuMaker UNO Evaluation Board is an Arduino compatible hardware using NuMicro® microcontroller (MCU) as the MCU. Its function can be extended with Arduino add-ons. With the Arduino IDE, users can develop their applications and leverage large number of open source samples.

![Figure 1-1 NuMaker UNO Board](image1.png)

The NuMaker UNO is a specific development tool for NuMicro® NUC131 series by which users can develop and verify the application program easily. Its purpose is to provide a platform for development and learning. With ADC, PWM, I2C, SPI, UART and other peripheral functions, user can set different functions on the NuMaker UNO development kit, or increase the peripheral functions according to the user needs on the development kit. The NuMaker UNO includes two portions: NuMaker UNO (an evaluation board) and Nu-Link-Me (Debug Adaptor). With the NuMaker UNO, users do not need additional ICE or debug equipment.

![Figure 1-2 NuMaker UNO Board with Different Add-ons](image2.png)

The NuMaker UNO is pin to pin compatible with Arduino UNO board.

Digital pins provide UART, I2C, LED, INT, and 10-channels PWM. In addition, the extended pins of MCU NUC131SD2AE provide 24-channels PWM and 6-channels UART. Clock Output (CLKO) is also available on extra pin.
2 FEATURES

The NuMaker UNO development board provides the following features:

- Wide range of development tools for Learning/applications/debug
- Portable package development and debugging tools
- Rich MCU peripheral functions, such as ADC, PWM, I²C, SPI, and UART
- Able to connect to different application modules due to high scalability
- Supports pin to pin compatible with Arduino UNO revision 3
- Supports USB virtual serial port (VCOM)
- Supported by a wide choice of Integrated Development Environments (IDEs) including Arduino IDE, IAR EWARM and Keil RVMDK IDE
- Extension resources:
  - NuMicro® Morpho extension pin headers for full access to all MCU NUC131 I/O
  - On-board Nu-Link debugger/programmer with SWD connector
- Flexible board power supply:
  - USB VBUS (jumper JPR1 can be used to select 5V or 3.3V)
  - External VIN (7V ~ 12V) supply voltage from transformer converted into 5V
  - External 2.5 ~ 5.5V supply voltage from other power source input to V_DD pin
- LEDs Status
  - Power, TX, RX, ICE and user status
- One push button: RESET
3  INTRODUCTION TO NUMAKER UNO DEVELOPMENT BOARD

Figure 3-1 and Figure 3-2 show the NuMaker UNO development board, in which the left portion is called NuMaker UNO target board and the right portion is Debug Adaptor called Nu-Link–Me.

The NuMaker UNO is similar to other development boards. Users can use it to develop and verify applications to emulate the real behavior. NuMaker UNO can be a real system controller to design user’s target system. NuMaker UNO is pin to pin compatible with Arduino UNO revision 3. The left portion is NuMaker UNO target board where the NUC131 series MCU is mounted on. The NUC131 series provides 24-ch PWM as well as 6-ch UART, and commonly used peripherals such as Timer, WDT, SPI, °C and ADC. The NUC131 series also provides CAN communication interface.

The right portion is the debug adaptor called Nu-Link–Me which connects the USB port from PC to user’s target system (via the Serial Wired Debug port) and allows users to program and debug embedded programs on the target hardware. In addition to loading external application, it also provides a virtual serial port (VCOM) functions. The debug messages through user-friendly Nu-Link–Me is displayed on the computer screen. For detailed description, please refer to section 3.1.2. The NuMaker UNO supports Arduino IDE, Keil, and IAR. For detailed installation and setup, please refer to section 4.1.

The NuMaker UNO development board provides the Arduino pin-out definition and extended connectors for each pin from the NUC131SD2AE MCU. It can be used to connect the application circuit board. The target board also supports a wide range of power supplies, such as from ICE, V_DD & GND (JP1 & JP2) or from 7V ~ 12V transformer. LED status is for power, I/O, TX, RX and ICE, as shown in Figure 3-1.

![Figure 3-1 NuMaker UNO Development Board – Upper Side](image)
Figure 3-2 NuMaker UNO Development Board – Bottom Side
3.1 NuMaker UNO Jumper Description

3.1.1 Power Settings

There are three methods to use the NuMaker UNO board to provide power to V<sub>DD</sub>. The first method is through the Nu-Link-Me USB interface. This power will go through LDO voltage regulator to 3.3V, JPR1 can be used to adjust V<sub>DD</sub> power to 5V or 3.3V. The second method is through the JP1 on development board to V<sub>DD</sub> by DC 2.5V ~ 5.5V power supply. The third method is through transformer (7V ~ 12V) and then the voltage is converted into 5V through the step-down circuit. Please refer to the table below.

<table>
<thead>
<tr>
<th>Model</th>
<th>JP1 (Selection Voltage)</th>
<th>JPR1 (V&lt;sub&gt;DD&lt;/sub&gt; Provided Voltage)</th>
<th>MCU Voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB</td>
<td>5V or 3.3V (Default is 5V)</td>
<td>USB, target board will be able to get the supply voltage. (SW2 pin1 need on)</td>
<td>DC 5V or 3.3V</td>
</tr>
<tr>
<td>Other power for V&lt;sub&gt;DD&lt;/sub&gt; pin</td>
<td>X</td>
<td>External power supply DC 2.5 V ~ 5.5 V. Voltage by JP1 input</td>
<td></td>
</tr>
<tr>
<td>Transformer</td>
<td>X</td>
<td>Transformer DC 7 V ~ 12 V, after pass the step-down circuit, it provides 5V supply to target chip (J2 need short)</td>
<td>DC 5V</td>
</tr>
</tbody>
</table>

Table 3-1 Power Settings

3.1.2 USB Virtual COM Function Setting

- **SW2**: Open the Virtual COM mode for the debug message and supply power to NuMaker UNO.

The Virtual COM function can be used for Arduino IDE, Keil and IAR. To enable VCOM function on Nu-Link Me, turn on all SW2 pins. To enable the UART0 function, turn off pin 2 ~ pin 4 on SW2. Please refer to the table below.

<table>
<thead>
<tr>
<th>Switch Pin Number</th>
<th>Function Name</th>
<th>UART0 Mode</th>
<th>VCOM Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ICE_VCC</td>
<td>On</td>
<td>On</td>
</tr>
<tr>
<td>2</td>
<td>VCOM_En</td>
<td>Off</td>
<td>On</td>
</tr>
<tr>
<td>3</td>
<td>VCOM_TX</td>
<td>Off</td>
<td>On</td>
</tr>
<tr>
<td>4</td>
<td>VCOM_RX</td>
<td>Off</td>
<td>On</td>
</tr>
</tbody>
</table>

Table 3-2 USB VCOM Setting (Default as VCOM Mode)
3.1.3 Header Description

| JP1  | VDD connector on NuMaker UNO, can be accessed by an external power supply DC 2.5V ~ 5.5V, in order to provide NuMaker UNO power supply |
| JP2  | GND connector on NuMaker UNO, can be accessed by external power supply GND |
| J1   | Mini USB connector on Nu-Link-Me connected to the PC USB port |
| SW2  | Pin 1 is ICE VDD connected to target chip VDD |
| CON1 | 7 V ~ 12 V transformer |
| J2   | Power JACK is connected to VDD transformer, after the step-down circuit then to provide VDD power supply to target Chip |
| SW1  | Reset button on NuMaker UNO |
| JP10 | Connector on target board (NuMaker UNO) for connecting to Nuvoton ICE adaptor (Nu-Link-Me) |
| JP9  | Connector on ICE adaptor (Nu-Link-Me) for connecting to the target board (NuMaker UNO) |
| JP3 ~ JP6 | Show all NUC131SD2AE MCU pin-out on NuMaker UNO |
| X    | Unused |

Table 3-3 Header Description

**Note:** When using the transformer power supply, please turn off all the SW2 pins.

3.2 Pin Assignment for NUC131SD2AE Extended Connectors

The NuMaker UNO provides the NUC131SD2AE target chip on board and the NUC131SD2AE extended connectors (JP3, JP4, JP5 and JP6) for LQFP64-pin. Table 3-4 shows the pin assignment for NUC131SD2AE.

<table>
<thead>
<tr>
<th>Pin No</th>
<th>Pin Name</th>
<th>Pin No</th>
<th>Pin Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>PB.14,INT0</td>
<td>33</td>
<td>PC.11,PWM1_BRAKE1</td>
</tr>
<tr>
<td>02</td>
<td>PB.13</td>
<td>34</td>
<td>PC.10,PWM1_BRAKE0</td>
</tr>
<tr>
<td>03</td>
<td>PB.12,CLKO,BPWM1_CH3</td>
<td>35</td>
<td>PC.9,PWM0_BRAKE1</td>
</tr>
<tr>
<td>04</td>
<td>PF.5,I2C0_SCL,PWM1_CH5</td>
<td>36</td>
<td>PC.8,PWM0_BRAKE0</td>
</tr>
<tr>
<td>05</td>
<td>PF.4,I2C0_SDA,PWM1_CH4</td>
<td>37</td>
<td>PA.15,PWM0_CH3</td>
</tr>
<tr>
<td>06</td>
<td>PA.11,I2C1_SCL,PWM1_CH3</td>
<td>38</td>
<td>PA.14,PWM0_CH2</td>
</tr>
<tr>
<td>07</td>
<td>PA.10,I2C1_SDA,PWM1_CH2</td>
<td>39</td>
<td>PA.13,PWM0_CH1,UART5_TXD</td>
</tr>
<tr>
<td>08</td>
<td>PA.9,I2C0_SCL,UART1_nCTS</td>
<td>40</td>
<td>PA.12,PWM0_CH0,UART5_RXD</td>
</tr>
<tr>
<td>09</td>
<td>PA.8,I2C0_SDA,UART1_nRTS</td>
<td>41</td>
<td>PF.7,ICE_DAT</td>
</tr>
<tr>
<td>10</td>
<td>PB.4,UART1_RXD</td>
<td>42</td>
<td>PF.6,ICE_CLK</td>
</tr>
<tr>
<td>11</td>
<td>PB.5,UART1_TXD</td>
<td>43</td>
<td>AVSS</td>
</tr>
<tr>
<td>12</td>
<td>PB.6,UART1_nRTS</td>
<td>44</td>
<td>PA.0,PWM0_CH4,ADC0,I2C1_SCL,UART5_TXD</td>
</tr>
<tr>
<td>13</td>
<td>PB.7,UART1_nCTS</td>
<td>45</td>
<td>PA.1,PWM0_CH5,ADC1,I2C1_SDA,UART5_RXD</td>
</tr>
<tr>
<td>14</td>
<td>LDO_CAP</td>
<td>46</td>
<td>PA.2,PWM1_CH0,ADC2,UART3_TXD</td>
</tr>
<tr>
<td>15</td>
<td>VDD</td>
<td>47</td>
<td>PA.3,PWM1_CH1,ADC3,UART3_RXD</td>
</tr>
<tr>
<td>16</td>
<td>VSS</td>
<td>48</td>
<td>PA.4,ADC4</td>
</tr>
<tr>
<td>17</td>
<td>PB.0,UART0_RXD</td>
<td>49</td>
<td>PA.5,UART3_RXD,ADC5</td>
</tr>
<tr>
<td>18</td>
<td>PB.1,UART0_TXD</td>
<td>50</td>
<td>PA.6,UART3_TXD,ADC6</td>
</tr>
</tbody>
</table>
Table 3-4 Pin Assignment for NUC131SD2AE

3.3 NuMaker UNO NUC131SD2AE Extended Connectors Layout
3.4 Arduino UNO Pin Assignment for NuMaker UNO

The NuMaker UNO provides the NUC131SD2AE target chip on board and the Arduino UNO extended connectors (NU1, NU2, NU3, NU4 and NU5) for LQFP64-pin. Table 3-5 shows the pin assignment for NuMaker UNO.

<table>
<thead>
<tr>
<th>Clock Output</th>
<th>Pin No</th>
<th>Pin Name</th>
<th>Power</th>
<th>Pin No</th>
<th>Pin Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CLKO</td>
<td>5</td>
<td>5V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>VCC</td>
<td>6</td>
<td>GND</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>RESET</td>
<td>7</td>
<td>GND</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>3.3V</td>
<td>8</td>
<td>Vin</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analog</td>
<td>1</td>
<td>A0</td>
<td>4</td>
<td>A3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>A1</td>
<td>5</td>
<td>A4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>A2</td>
<td>6</td>
<td>A5</td>
<td></td>
</tr>
<tr>
<td>Digital</td>
<td>0</td>
<td>PB.0/UART_RX0</td>
<td>9</td>
<td>PA.14/PWM0_CH2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>PB.1/UART_TX0</td>
<td>10</td>
<td>PA.13/PWM0_CH1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>PF.4/PWM1_CH4</td>
<td>11</td>
<td>PA.12/PWM0_CH0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>PF.5/PWM1_CH5</td>
<td>12</td>
<td>PB.15/TM0/INT1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>PA.10/PWM1_CH2</td>
<td>13</td>
<td>PB.13(LED)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>PA.11/PWM1_CH3</td>
<td>VSS</td>
<td>VSS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>PA.15/PWM0_CH3</td>
<td>VREF</td>
<td>VREF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>PE.5/PWM0_CH5</td>
<td>I2C</td>
<td>PA.8/SDA</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>PB.11/PWM0_CH4</td>
<td>I2C</td>
<td>PA.9/SCL</td>
<td></td>
</tr>
<tr>
<td>SPI Interface</td>
<td>1</td>
<td>PC.2/SPI0_MISO</td>
<td>5</td>
<td>RESET</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Vdd</td>
<td>6</td>
<td>GND</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>PC.1/SPI0_CLK</td>
<td>7</td>
<td>PC.0/SPI0_SS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>PC.3/SPI0_MOSI</td>
<td>8</td>
<td>PB.9/TM1</td>
<td></td>
</tr>
</tbody>
</table>

Table 3-5 Pin Assignment for NuMaker UNO
3.5 NuMaker UNO Arduino Layout

![NuMaker UNO Pin Design for Arduino](image)

**Figure 3-4** NuMaker UNO Pin Design for Arduino
3.6 NuMaker UNO PCB Placement

Figure 3-5 NuMaker UNO PCB Placement
4 DOWN LOADING AND INSTALLING A RDUINO IDE 1.8.5 AN D NUMA KER UNO SOFTWARE

4.1 Downloading and Installing Arduino IDE 1.8.5 Software

Please visit the Arduino official website (http://www.arduino.cc/en/Main/software) to download and install the Arduino IDE 1.8.5. Currently it is recommended to install Arduino IDE 1.8.5 for Windows version, since the other operating system has not been verified.

The Arduino IDE 1.8.5 installation steps are as follows:

4.1.1 Step 1: Download Arduino IDE 1.8.5 software


Download the Arduino IDE

ARDUINO 1.8.5
The open-source Arduino Software (IDE) makes it easy to write code and upload it to the board. It runs on Windows, Mac OS X, and Linux. The environment is written in Java and based on Processing and other open-source software.
This software can be used with any Arduino board.
Refer to the Getting Started page for Installation instructions.

Figure 4-1 Find and Click “previous version of the current release”
4.1.2  **Step 2: Check if download file is version 1.8.5**

Click on download.

![Contribute to the Arduino Software](image)

Figure 4-2 Find and Download Arduino 1.8.5

4.1.3  **Step 4: Install the “Arduino-1.8.5-windows.exe” file**

Double click on the "arduino-1.8.5-windows.exe" and click “Run”.

![Open File - Security Warning](image)

Figure 4-5 Install arduino-1.8.5-windows.exe Installation File
4.1.4 **Step 5: Select the installation folder**

Select the installation folder and click “Install”.

![Install Arduino](image)

**Figure 4-6 Install arduino-1.8.5-windows.exe to Installation Folder**

4.1.5 **Step 6: Wait for the installation is complete**

Wait the installation process until it is finished. It will take about 2 minutes to install arduino-1.8.5-windows file to the installation folder.

![Install Arduino](image)

**Figure 4-7 Install arduino-1.8.5-windows to Installation Folder**

After installation is finished, two executable files can be found in the Arduino 1.8.5 installation directory, including arduino.exe and arduino_debug.exe. Both files are able to start the Arduino
IDE program. As for the arduino_debug.exe, you can open the debug window. When the program is executed or compiled, the debug window will open for users to check which part of the problem occurs.

![Figure 4-8 Arduino 1.8.5 Installation Directory](image)

### 4.2 Installing Nu-Link USB Driver for Arduino IDE 1.8.5

Please visit the Nuvoton NuMaker UNO official website ([www.nuvoton.com/NuMaker_UNO](http://www.nuvoton.com/NuMaker_UNO)) to download "Nu-Link USB Driver".

**Note:** It is recommended to use Arduino IDE version 1.8.5.

The Nu-Link USB Driver installation steps are as follows:

#### 4.2.1 Step 1: Download Nu-Link USB Driver

Visit [www.nuvoton.com/NuMaker_UNO](http://www.nuvoton.com/NuMaker_UNO) and find Resources. Click on "Nu-Link USB Driver".

![Figure 4-9 Find and Click Nu-Link USB Driver](image)
4.2.2 Step 2: Select the installation folder

Select the installation folder and click “Next” to install.

![Figure 4-10 Installing Nu-Link USB Driver](image)

4.2.3 Step 3: Run Arduino IDE 1.8.5

Go to File → Preferences, enter the following URL to textbox of ‘Additional Board Manager URLs’:

https://raw.githubusercontent.com/OpenNuvoton/NuMaker-UNO/master/package_nuvoton_index.json

![Figure 4-11 Arduino IDE 1.8.5 Select File and Click Preferences](image)
4.2.4 **Step 4: Install NuMaker UNO on Arduino IDE 1.8.5 Boards Manager**

Go to **Tools → Board → Boards Manager** on Arduino IDE 1.8.5.

![Click Boards Manager on Arduino IDE 1.8.5](image)
Search “NuMaker” and the NuMaker UNO will show up on the list. Select NuMaker UNO and click install.

![Boards Manager](image)

Figure 4-14 Select NuMaker UNO and Click Install

### 4.2.5 Step 5: Select NuMaker UNO on Arduino IDE 1.8.5 Board Selection

After the package download is finished, go to **Tools → Board** and select NuMaker UNO to use it.

![Board Selection](image)

Figure 4-15 Select NuMaker UNO on Board Selection to Use It
4.3 Hardware Setup
Hardware connections are shown in the figure below. Use a mini USB to connect to a computer.

![Figure 4-16 NuMaker UNO Connected to Computer](image)

4.4 Testing USB and VCOM Device in the Device Manager
Before connecting the NuMaker UNO development board to the computer, please enable SW2 of VCOM Function. All the SW2 pins shall be turned on. Please refer to section 3.1.2. Open the device manager and check if the USB is detected. If it is not detected, please reinstall the Nu-Link USB Driver.

![Figure 4-17 USB Device Detected by Device Manager](image)
5 STARTING TO USE NUMAKER UNO ON ARDUINO IDE 1.8.5

5.1 Compiling and Executing Example Program

This example demonstrates how to download an application and debug using virtual serial port on a NuMaker UNO board. When users install the Nu-Link USB Driver, the “NuMaker UNO” can be found in Arduino IDE on Tools → Board → NuMaker UNO as shown in the figure below.

Note: Execute the “arduino_debug.exe” file in the installation path.

5.1.1 Step 1: Select the NuMaker UNO Board

![Figure 5-1 NuMaker UNO Board Selection on Arduino IDE](image)

5.1.2 Step 2: Open virtual serial modes and select Debug Serial Port

SW2: Supply power to NuMaker UNO. Before NuMaker UNO is connected to PC, all the SW2 pins shall be turned on. To activate UART0 function, SW2 pin2 ~ pin4 shall be turned off.

<table>
<thead>
<tr>
<th>Switch Pin Number</th>
<th>Function Name</th>
<th>UART0 Mode</th>
<th>VCOM Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ICE_VCC</td>
<td>On</td>
<td>On</td>
</tr>
<tr>
<td>2</td>
<td>VCOM_En</td>
<td>Off</td>
<td>On</td>
</tr>
<tr>
<td>3</td>
<td>VCOM_TX</td>
<td>Off</td>
<td>On</td>
</tr>
<tr>
<td>4</td>
<td>VCOM_RX</td>
<td>Off</td>
<td>On</td>
</tr>
</tbody>
</table>

Table 5-1 SW2 Mode Setting (Default as VCOM Mode)
After SW2 setting is completed, you will be able to see the serial COM port number.

![Figure 5-2 Select NuMaker-UNO Serial COM Port](image)

**Note 1:** If the SW2 pin 2 of VCOM function is not enabled, **Tools → Port** will become gray (disabled), unless the board is re-connected to the computer. However, before re-connecting to PC, you must open the VCOM function.

**Note 2:** If the serial port number is not selected, you will not be able to use the serial monitor.

![Figure 5-3 COM port Not Detected and Unable to Use Serial Monitor](image)

**5.1.3 Step 3: Open the sample code**

Open the sample code through **File → Examples → 03.Analog → AnalogInOutSerial.**

![Figure 5-4 Open the Sample Code](image)
5.1.4 Step 4: Download the sample code

Use the Upload button to compile and load code to target board or use the Verify button to compile code.

1. Upload: This button can compile and load code to a target board.
2. Verify: This button can compile code.
3. Serial Monitor: This button can open the serial monitor.

![Figure 5-5 Sample Program Compiled and Loaded](image)

5.1.5 Step 5: Check the Correctness of the VCOM Baud Rate

User needs to check if the virtual serial port baud rate setting is the same as the program setting. When the program is set to 9600, the virtual serial port monitor will be set as 9600.
This example uses ADC0 to perform ADC conversion into a digital value which is then displayed by the virtual serial port out. To set a COM port baud rate and then display the virtual serial conversion results, use the ADC0 pin connected to V_{DD} or V_{SS}. Then, whether the ADC conversion result is correct can be displayed.
Figure 5-8 Serial Monitor Shows ADC0 Conversion Result
6 STARTING TO USE NUMAKER UNO ON KEIL µVISION® IDE

6.1 Downloading and Installing Keil µVision® IDE Software
Please visit the Keil official website (http://www.keil.com) to download the Keil µVision® IDE and install the RVMDK.

6.2 Downloading and Installing Nu-Link Keil Driver
Please visit Nuvoton NuMicro® official website (http://www.nuvoton.com/NuMicro) to download the “NuMicro Nu-Link Keil Driver” file. Please refer to section 8.1 for the detailed download flow. After the Nu-Link driver is downloaded, please unzip the file and execute the “NuLink_Keil_Driver.exe” to install the driver.

6.3 Hardware Setup
The hardware setup is shown in the figure 6-1. If users want to use the VCOM function, turn on all the SW2 pins (refer to section 3.1.2).

![Figure 6-1 NuMaker UNO Connected to the Computer](image)

6.4 Procedure for Downloading and Debugging Example Program
This example demonstrates how to download and debug a program on the NuMaker UNO board. The example file can be found in the directory list as shown in the following figure.

6.4.1 Step 1: Open the Project
Please open the following path.
“C:\Nuvoton\BSPLibrary\NUC131BSP_CMSIS_v3.00.001\SampleCode\StdDriver\ADC_Result Monitor\KEIL”
6.4.2 Step 2: Check Device Chip and Debug Chip

Please open the “target options” to check the device chip and if the debug chip selection is correct. Figure 6-3 shows the correct device chip selection. Figure 6-4 shows the correct debug chip selection. Figure 6-5 shows the debugging tool to confirm the selection is correct.
Figure 6-3 Select Device Chip

Figure 6-4 Select Debug Chip
6.4.3 Step 3: Build and Download Sample Code
Click the Build button to see the completed compilation for error if any, and finally load the code to the development board.

6.4.4 Step 4: Open the Serial Monitor and Set Baud Rate
User can open the serial monitor to print debug message. The present example uses the “PuTTY tool”.

Figure 6-5 Select Nuvoton Debugger Tool (Nu-Link)
6.4.5 Step 5: Click the Reset Button to Run Your Code.

After clicking the Reset button, chip will re-execute the program. The debug messages are displayed as shown below.
Function Button Description:

1. Open μVision® Development Tool
   Project – Open
   • Open the SYS.uvproj project file (Step 1 in Figure 6-8)

2. Project – Build
   • Compile and link the SYS application (Step 2 in Figure 6-9)

3. Flash – Download
   • Program the application code into on-chip Flash ROM (Step 3 in Figure 6-9)

4. Open Debug Mode (Step 4 in Figure 6-9)
   When using the debugger commands, it has the following features:
   a. Window View to detect changes in the value of variables and registers (Step 4a in Figure 6-10)
   b. Single-Step through code (Step 4b in Figure 6-10)
   c. RST Reset the device (Step 4c in Figure 6-10)
   d. Run the application (Step 4d in Figure 6-10)

Figure 6-8 ADC Sample Code Path
Figure 6-9 ADC Enter Compile Mode Interface

Figure 6-10 ADC Enter Debug Mode Interface
7 STARTING TO USE NUMAKER UNO ON IAR EMBEDDED WORKBENCH

7.1 Downloading and Installing IAR Embedded Workbench Software
Please visit IAR official website (http://www.iar.com) to download the IAR Embedded Workbench and install the EWARM.

7.2 Downloading and Installing Nu-Link IAR Driver
Please visit Nuvoton NuMicro® official website (http://www.nuvoton.com/NuMicro) to download “NuMicro Nu-Link IAR Driver” file. Please refer to section 8.2 for the detailed download flow. After the Nu-Link driver is downloaded, please unzip the file and execute the “Nu-Link_IAR_Driver.exe” to install the driver.

7.3 Hardware Setup
The hardware setup is shown in the figure 7-1. If users want to use the VCOM function, please turn on all the SW2 pins. Please refer to section 3.1.2.

![Figure 7-1 NuMaker UNO Connected to the Computer](image)

7.4 Procedure for Downloading and Debugging Example Program
This example demonstrates how to download and debug an application on a NuMaker UNO board. The example file can be found in the directory list as shown in the following figure.

7.4.1 Step 1: Open the Project
Please open the following path example program.
"C:\Nuvoton\BSPLibrary\NUC131BSP_CMSIS_v3.00.001\SampleCode\StdDriver\ADC_Result Monitor\IAR".
7.4.2 Step 2: Download the Sample Code.

Click the button on the top right corner to download the program.

7.4.3 Step 3: Click the Reset Button to Run Your Code

After clicking the Reset button, the chip will re-execute the application and debug messages are displayed.
Function Button Description:

- **Open IAR Embedded Workbench**
  - **File – Open – Workspace**
  - Open the SYS.eww workspace file

- **Project – Make**
  - Compile and link the SYS application

- **Project – Download and Debug**
  - Program the application code into on-chip Flash ROM. It has the following features:
    - Single-step through code
    - Reset the device
    - Run the application
## 8 DOWNLOADING NU-LINK DRIVER FROM NUVOTON WEBSITE

### 8.1 Downloading and Installing Nu-Link Keil Driver

<table>
<thead>
<tr>
<th>Step</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Visit Nuvoton NuMicro® Website: <a href="http://www.nuvoton.com/NuMicro">http://www.nuvoton.com/NuMicro</a></td>
</tr>
</tbody>
</table>
| 2    | 2.1. Move to “Support”  
2.2. Click here to enter “Tool & Software”  
Support |
| 3    |  
Software  
Click here to enter “Software” download page  
Software  
Development Tool Hardware  
Third Party Tool  
Support Package  
Mini51 Series B5  
Revision History  
Mini51 series software package and samples codes, Exan |
Step 4

Download “Nu-Link Keil Driver for Keil RVMDK” file. After download is complete, unzip the file and execute “Nu-Link_Keil_Driver.exe”. Follow the instructions to install Nu-Link Keil driver.

Nu-Link Driver

Click here to download “Nu-Link Keil Driver”

Step 5

Download “Nu-Link Driver for Keil RVMDK” file. After download is complete, unzip the file and execute “Nu-Link_Keil_Driver.exe”. Follow the instructions to install Nu-Link Keil driver.
## 8.2 Downloading and Installing Nu-Link IAR Driver

| Step 1 | Visit Nuvoton NuMicro® Website: http://www.nuvoton.com/NuMicro |

### Step 2
- **2-1. Move to “Support”**

### Step 3
- **2-2. Click here to enter “Tool & Software”**

---

Click here to enter “Software” download page
### Step 4

**Programmer Software Tools Package**

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
<th>Version</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICP_Programming_Tool_V2.00.5551</td>
<td>NuMicro ICP tool &amp; user manual</td>
<td>V2.00.5551</td>
<td>2016-8-16</td>
</tr>
<tr>
<td>ISP_Programming_Tool_V2.00.zip</td>
<td>NuMicro ISP programming tool &amp; user manual</td>
<td>V2.00</td>
<td>2015-9-7</td>
</tr>
<tr>
<td>NuGang_Programmer_V7.02.zip</td>
<td>NuGang programmer software &amp; user manual</td>
<td>V7.02</td>
<td>2015-11-27</td>
</tr>
</tbody>
</table>

**Nu-Link Driver**

<table>
<thead>
<tr>
<th>File name</th>
<th>Description</th>
<th>Version</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nu-Link_Kell_Driver_V2.00.6561</td>
<td>This driver is to support Nu-Link to work under</td>
<td>V2.00.6561</td>
<td>2016-8-16</td>
</tr>
<tr>
<td>Nu-Link_IAR_Driver_V2.00.6561</td>
<td>IAR EWARM Development Environment for all NuMicro</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Family Devices</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Click here to download “Nu-Link IAR Driver”

### Step 5

Download “Nu-Link Driver for IAR” file. After download is complete, unzip the file and execute “Nu-Link\_IAR\_Driver.exe”. Follow the instructions to install Nu-Link IAR driver.
9 NUMAKER UNO SCHEMATICS

9.1 NuMaker UNO I/O Schematic

Crystal

Reset

Power

Arduino interface

input voltage (7V to 12V)
9.2 NuMaker UNO NUC131SD2AE Schematic
9.3 Nu-Link-Me Schematic
### 10 REVISION HISTORY

<table>
<thead>
<tr>
<th>Date</th>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2015.07.20</td>
<td>1.00</td>
<td>1. Initially issued.</td>
</tr>
<tr>
<td>2016.11.02</td>
<td>1.01</td>
<td>1. Changed the board name from NuEdu-UNO to NuMaker UNO.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Updated NuMicro® Patch for Arduino 1.5.8 to Nu-Link_USB_Driver_V1.2 in section 4.2.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Added section 3.3 NuMaker UNO NUC131SD2AE Extended Connectors Layout.</td>
</tr>
<tr>
<td>2018.08.20</td>
<td>1.02</td>
<td>1. Update installing instruction in section 4.1, 4.2.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Update NuMaker-UNO package for Arduino 1.8.5</td>
</tr>
</tbody>
</table>

---

**Important Notice**

Nuvoton Products are neither intended nor warranted for usage in systems or equipment, any malfunction or failure of which may cause loss of human life, bodily injury or severe property damage. Such applications are deemed, “Insecure Usage”.

Insecure usage includes, but is not limited to: equipment for surgical implementation, atomic energy control instruments, airplane or spaceship instruments, the control or operation of dynamic, brake or safety systems designed for vehicular use, traffic signal instruments, all types of safety devices, and other applications intended to support or sustain life.

All Insecure Usage shall be made at customer’s risk, and in the event that third parties lay claims to Nuvoton as a result of customer’s Insecure Usage, customer shall indemnify the damages and liabilities thus incurred by Nuvoton.